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•	 Option A. Instructions for downloading the Survey123 app on your smart phone or tablet 
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•	 Option B. Retrieving data using Survey123 website [jump to section]
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Requesting Credentials to the EPA Sanitary Survey App                                   
Request Access Credentials (Username and Password)
Before you can access the EPA Sanitary Survey App for Marine and Fresh Waters you will need to 
request a username and password from EPA. Go to https://request.ercloud.org/requestaccount to 
request your credentials using the GeoPlatform User Account Request Form (Figure 1). All fields on 
the form will need to be completed and click the box “I’m not a robot”. For the Response/Project, 
select Freshwater and Marine Sanitary Survey.

At time of account creation, your account will be set to a General User which only has permission to 
submit, view, edit and download your own data. 

After the GeoPlatform User Account Request Form is submitted, you will receive a username and 
temporary password within 48 hours. Your access credentials will allow you to access the surveys 
using Survey123 on your smartphone and computer as well as download your data from EPA’s Geo-
Platform (see detailed instructions on the following pages). 

•	 External users (i.e., non-EPA), when you sign into the ArcGIS Online (see Step A.2a), you 
will be prompted to change your password. 

•	 EPA user accounts will be linked to their LAN User ID after requesting access to the App. 
Follow the instructions in Step A.2b to login into ArcGIS Online.  

Figure 1. Sanitary Surveys GeoPlatform User Account Request Form

https://request.ercloud.org/requestaccount
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Accessing the Survey123 Application                                                              
 
This section contains instructions for accessing the EPA Sanitary 
Survey App for Marine and Fresh Waters using the Survey 123 
app on a mobile device (e.g., phone, tablet) and a web browser. 
The Survey123 app and the EPA Sanitary Survey App should be 
downloaded before going into the field. By downloading the sur-
veys in advance, you will be able to access and complete them 
without the need for WiFi or an Internet connection. 

Option A: Instructions for Downloading the Survey123 App on Your Smart Phone or 	
              Tablet

Step A.1: Download Survey123 Application to Use the EPA Sanitary Surveys for Marine and Fresh 
Waters

Download and install the Survey123 application (Figure 2) onto 
your mobile device via the Google Play Store or Apple app store. 

Step A.2a. Sign in to Survey123 for External Users

(1) Enter the username and temporary password 
provided to sign in to ArcGIS Online (Figure 3). Note 
that the extension “EPAEXT” in the username is not 
case sensitive.

Figure 2. Icon for Survey123

Figure 3. Login Screen for ArcGIS Online

Important
If there is no WiFi or Internet 
connection in the field, down-
load the surveys before going 
into the field to conduct the 

sanitary survey.

(1)

https://play.google.com/store/apps?hl=en
https://www.apple.com/ios/app-store/
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(2) Once you have logged in for the first time, you will be prompted 
to change your password (Figure 4). Enter the old password and 
then a new password and re-enter new password in Confirm 
password following the password tips provided.

(3) You will then be prompted to enter a security question (Figure 
5). Once you’ve completed this step you will see the My Survey 
123 home screen and you can begin downloading the surveys 
by following the steps for downloading and using the sanitary 
surveys.

Figure 4. Password change screen

Figure 5. Security question screen

Password Tip
• Password must not match username

• Cannot be same as old password
• Must be at least 13 characters long
• Contain at least 1 letter(s) (A-Z, a-z)
• Contain at least 1 number(s) (0-9)
• Must be different from the last 12 

passwords

(2)

(3)

Note

If you are unable to access the surveys, please 
contact EPA_SanitarySurveyApp@epa.gov.  

Accessing the Survey123 Application 

mailto:EPA_SanitarySurveyApp@epa.gov
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A.2b. Sign in to Survey123 for EPA Users

(1) Select Your ArcGIS organization’s URL (Figure 6)

(2) Type in “EPA” (not case sensitive) as the organization and select Continue (Figure 7).

(3) You will then be redirected to a second screen (Figure 8). Select EPA Enterprise again. 

(4) Enter your EPA LAN User ID and Password or use your PIV card PIN (computer) to log in (Figure 
9).  

Figure 6. EPA user login in Figure 7. Enter “EPA”

Figure 8. Select EPA Enterprise Figure 9. Enter your LAN username and 
password or log in with your PIV card

(2)

(1)

(3)
(4)

Accessing the Survey123 Application 

(4)
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Option B: Instructions for Using Your Computer or Web Browser             
Step B.1. To access go to: https://epa.maps.arcgis.com/home/index.html. Then click on the Sign In 
button on the top right corner (Figure 10). 

 

Step B.2. To sign in, external users will need to 
follow Step A.2a, while EPA users will need to 
follow Step A.2b. These steps are on pages 
3 - 5 (Figure 11).

Step B.3: Select Groups on the main menu (Figure 12).

Figure 10. GeoPlatform main screen

Figure 11. Sign in window

Accessing the Survey123 Application 

Figure 12. GeoPlatform main menu after logging in

EPA users

External users

https://epa.maps.arcgis.com/home/index.html
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Step B.4. Select the Group Freshwater and Marine Sanitary Surveys – General Users (Figure 13). 
In the Recently added content (Figure 14) you can view some of the surveys. Select View All Group 
Content at the top of the icons (shown in Figure 14) or at the bottom of the page to see all of the 
surveys. 

 

 

You will find four types of files in this folder for each of the sanitary surveys: a Web Map, a Form, 
and two Feature Layers. You can hover over the icon to see the name of the file type. Web Maps and 
Feature layers are part of each survey form and the Form pulls data from each of these files.

Accessing the Survey123 Application 

Figure 14. Sanitary survey files types on the EPA GeoPlatform

Figure 13. Freshwater and Marine Sanitary Surveys -- General User-Group

Feature Layer for 
User Permissions

Form Feature Layer for 
Accessing Data

Web Map
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Step B.5. Select only the Form (i.e., with the swimmer pictogram or 
paper icon          in Figure 14) by clicking on the name of the survey 
form (e.g., Marine Sanitary Survey). Once the form opens, you can 
choose to either open the survey in the browser or in the Survey123 
app. Click on Open in Survey123 drop-down menu, and then select 
Open in browser or Open in Survey123 app (Figure 15). If you select 
the Open in Survey123 app, you will be redirected to a download 
page.

Step B.6. Click Download to download the Survey123 
app. You will be redirected again to the ArcGIS Survey123 
Resource Page. Scroll to the end of the page and down-
load the appropriate ArcGIS Survey123 field app for your 
processing system (Figure 16).

Step B.7. Once you’ve downloaded the Survey123 app 
on your computer, follow the steps for downloading and 
using the sanitary surveys on pages 3 - 5. External users 
will need to follow Step A.2a, while EPA users will need to 
follow Step A.2b to sign in.

Note

After clicking on the sur-
vey form, the name list-
ed here will not be yours 
but rather the name of 

the developer.

Accessing the Survey123 Application 

Figure 16. Download for your 
processing system  

Figure 15. Opening Survey123 from your browser
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Steps for Downloading and Using the Sanitary Survey                                     
1. Instructions for Downloading the Survey in the App

Step 1: Download EPA Sanitary Surveys in Survey123

As a first-time user of the App, once you log into the Survey 123 
app with your credentials, you should see an image like Figure 17 
that says, “Looks like you don’t have any surveys on your device.” 
Select Download Surveys. Then go to Step 2a. If you had previously 
downloaded surveys as an alpha or beta tester or if a new version 
of the survey is released, you will need to update your surveys to 
the latest versions (see Step 2b). 

Step 2a: Downloading Surveys for First Time

Select the sanitary survey(s) you wish to download to your device: 

•	 Marine Routine Survey
•	 Marine Annual Survey
•	 Freshwater Routine Survey
•	 Freshwater Annual Survey

There may be a slight delay in seeing the surveys because they are 
loading. Downloads occur one at a time by selecting each download 
icon  next to each survey. After downloading the surveys for the 
first time, go to Tips on Completing the Survey (page 11) or Instruc-
tions for Submitting and Saving Sanitary Survey Data (page 13). 

Step 2b: Downloading Newer Versions of Surveys 

If you were a volunteer tester of the alpha and beta versions of 
the EPA sanitary surveys and these surveys are still on your My 
Surveys page of Survey123, you will need to download the latest 
versions of the surveys before you can begin using them. When 
downloaded, newer versions of the surveys will appear on your 
My Surveys page as new surveys and will not replace the old sur-
veys on your device. Follow these instructions when downloading 
newer versions. 

Delete old surveys first: It is recommended that you delete the 
old surveys before downloading new, updated surveys. There 
isn’t a batch process to delete all old surveys at once, so each 
old survey will have to be deleted individually. To delete old sur-
veys, open each survey by clicking on the survey icon; and then 
click on the triple horizontal bars on the upper right-hand corner 
(Figure 18); and then click Delete Survey. Make sure you do it for 
each survey. 

If old surveys aren’t deleted, multiple versions will appear on your My Surveys page, making it dif-
ficult to determine the latest version without opening each survey. Additionally, if you use an older 
version of the surveys, you may not find your data. 

Figure 17. Download surveys in 
Survey123

Tip
Delete old surveys be-
fore downloading new, 
updated surveys. See 

Step 2.b for help.

Figure 18. How to delete surveys

Downloading and Using the Sanitary Survey
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After deleting all old surveys, you can proceed with downloading the newer versions. You may see 
on your My Surveys screen notification that there are updates available (Figure 19). 

To download the latest versions, begin by selecting the Person icon  in Figure 19 or your initials 
 (this is the icon to the right of  icon on the top right of the page). 

Click to download the survey. A list of surveys to be updated will appear. If the 
survey needs to be updated, it will have a cloud icon  next to it.  Click the cloud icon next to each 
survey.  

From time to time, based on user feedback and enhancements, the surveys will be updated. EPA 
will notify users when newer versions of the surveys have been released, so users can ensure they 
are using the latest versions. These instructions can be used to download newer versions of the 
surveys. 

Return to My Surveys by selecting the back arrow . 

Step 4: Opening the Survey

Select the survey you plan to complete by clicking on the survey icon (e.g., the marine annual survey 
has this icon).

Click the Collect button at the bottom of the screen to open 
the survey to begin entering your sanitary survey data. 

Give Survey123 permission to access your location or camera 
data to allow for full application functionality.

Step 5: Begin Collecting Data

Begin entering data. Use the navigation arrow buttons at the 
bottom of the screen (Figure 20) to navigate through the sur-
vey pages.

Figure 19. Updates available notification 

Navigation arrow button

Figure 20. Freshwater Routine Sanitary 
Survey - Page 1

Downloading and Using the Sanitary Survey
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2. Tips on Completing the Survey

Survey Features 

While several questions at the beginning of the survey are required (as indicated by a red asterisk, 
*) the bulk of the survey questions are optional. As you enter the data, you will see the following 
features: embedded questions when entering certain responses; questions with repeats that allow 
you to enter data for up to 10 entries; sections that collapse to hide information and reduce length 
of survey; and sections for taking (multiple) photos.  See the screenshots to learn more about these 
features.

Embedded questions that appear when you select Yes for certain responses (e.g., 
Observed, etc.) in certain sections of the surveys.  Below is an example of how Part 3: 
Bather Load expands to show embedded questions after selecting “Yes.”

Questions with repeats that allow you to enter data for up to 10 entries. In the exam-
ple below, press “+” to add more entries 

Downloading and Using the Sanitary Survey

Click here to add 
more entries
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Sections that collapse to hide information and reduce length of survey. In the example 
below, pressing the arrow on the top left will collapse the list of activities and “+” to 
expand the section. 

Sections for taking or uploading (multiple) photos.  In the example below, press “+” 
to add more photos.

Collapse or
Expand

Expand

Downloading and Using the Sanitary Survey

Click here to add 
more entries

Click here to upload 
photos from a file on 

your device

Click here to launch the 
camera on your device
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3. Instructions for Submitting and Saving Sanitary Survey Data  

Submitting the Survey

Step 1. Once you’ve completed the 
survey, use the check button  at 
the end of the survey to validate the 
submission (Figure 21). Once the app 
checks that all the required fields are 
filled in, the survey will be considered 
complete and ready to be submitted to 
the EPA GeoPlatform. 

If you don’t click the check button, 
your work will not be saved.

Step 2. The Survey Completed window (Figure 22) will appear with 
three choices – Send now; Continue this survey; or Save this sur-
vey in the Outbox.

•	 Send now: This will upload your data to the EPA GeoPlat-
form if you have WiFi or Internet access. Once your data 
is on the GeoPlatform you can view and download. 

•	 Save this survey in the Outbox: This will save your survey 
to the Outbox folder on the introduction screen for the 
survey below the Collect button. This is a great option 
if your device is offline or you have no WiFi or Internet 
access, 

	» Once you have reconnected to WiFi or the Internet, 
return to the saved survey in the Outbox to submit 
your survey to the EPA GeoPlatform. 

All surveys sent to the EPA GeoPlatform are saved to a Sent 
folder on the introduction screen for the survey below the Collect 
button (Figure 26). These surveys can be edited and resubmit-
ted or data can be copied to a new survey (Figure 23). An edited 
and resubmitted survey will replace the previously submitted 
data. Surveys submitted can also be viewed in the Inbox (Figure 
26). Select Inbox and then Refresh to load the surveys you have 
submitted.  

Validate submission 
“Check” Button icon

Figure 21. Freshwater Routine Sanitary Survey 
- Page 6

Figure 22. Survey completed screen

Figure 23. Edit or resubmit survey

Downloading and Using the Sanitary Survey
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Closing and Returning to your survey at a later time

By clicking the close button in the top 
left-hand corner (Figure 24), you will 
be prompted to Save the Survey in the 
Drafts (Figure 25). The draft survey 
will be saved in a Draft folder on the 
intro screen for that survey below the 
Collect button (Figure 26). To edit or 
complete the draft survey, reopen the 
same survey form again, select the 
Drafts folder and find the draft survey 
file you want to complete. Begin adding 
additional information to complete the 
survey.

Survey Homepage

Based on your selection in the previous steps, the intro 
page for your survey may look like Figure 26. 

•	 The Collect button will start a new survey
•	 The Inbox and Drafts buttons store surveys that 

have been started but not yet submitted.
•	 The Sent button stores all surveys that have 

been sent. Here you can edit and resubmit or 
copy surveys as discussed on page 13 and 14.

Close button

Figure 24. Freshwater Routine Sanitary Survey 
- Page 6

Tip
Unable to complete 
a survey? That’s OK 

-- save your surveys as 
a draft and come back 

later

Figure 25. Saving the survey as a draft

Downloading and Using the Sanitary Survey

Figure 26. Freshwater Routine Survey intro page

The little notification numbers will update to match 
the number of surveys you have submitted and 

drafts that you have saved
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Viewing and Exporting Your Sanitary Survey Data                                               
It is best to view and download your data from a computer rather than your smart phone. There are 
two platforms which may be used to view and download your data (Option A being the EPA ESRI 
GeoPlatform [jump to section] and Option B being the Survey123 website [jump to section]). These 
two options are discussed in this section. The best way to view your data is in Survey123 for ArcGIS. 

Option A: Retrieving Data Using EPA’s ESRI GeoPlatform

Step A.1: Sign into EPA’s ESRI GeoPlatform

•	 Open a web browser and navigate to the EPA’s ESRI GeoPlatform

	» https://epa.maps.arcgis.com/home/index.html

•	 Log in with your username and password

Step A.2: Find your data

•	 After logging in, click on the Groups on the main menu (Figure 20). 
•	 Select “Freshwater and Marine Sanitary Surveys – General User” (Figure 21).

In the “Freshwater and Marine Sanitary Surveys – General User”, you will see Web Maps, Forms 
and Feature Layer files (see Step 3.4) for each survey. The data you submitted is stored in the Fea-
ture Layer called “Access Your Data” for each respective survey (Figure 27). 

Step A.3: Access your data

Click on the Feature Layer called “Access Your Data” for the survey for 
which data was collected (Figure 27).  

This will open the Access Your Data Figure 28 on page 16. From here, 
you can choose to view and/or export your data.

Step A.4. View your data 

Once you open Access Your Data (Figure 28), you can view your data several ways:

•	 Using the Data tab to view data in tabular format (Figure 29). This is the best option for 
viewing your data and photos.

•	 Using the Visualization tab to view data spatially (Figure 30). 
•	 Using the Map Viewer to view data in tabular and map forms (Figure 31).

Tip

Survey 123 for ArcGIS is the best way to view your data 
and photos. Use your computer not your smartphone to 

view and download data.

Figure 27. Access data icon

Retrieving your Sanitary Survey Data

https://epa.maps.arcgis.com/home/index.html
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View your data using the Data tab

Figure 29 shows data for surveys conducted using the Data tab. Use the scroll bars at the bottom of 
the table to navigate through the various sections of the survey (from left to right).  You may also 
use the drop-down menu to view specific sections of the survey.

Tip

The data tab is the best option for viewing your data 
and photos on the GeoPlatform

Figure 28. View data submitted to the GeoPlatform

Figure 29. Data display from the data tab

Dropdown Menu

Retrieving your Sanitary Survey Data
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View your data using the Visualization tab

Figure 30 shows the data displayed spatially using the Visualization tab. When viewing data using 
Visualization, you may need to adjust the map (i.e., zoom in or out) to see your data point(s) on the 
map. Click on a data point to view the data collected. 

When there are many points in the same area of the map, you may need to disable or adjust the 
clustering in order to find your data. To do so, click on the Cluster Points icon shown in Figure 31 
and the Enable Clustering menu will appear. You can also see how to scroll between multiple sam-
ple points that are clustered closely together (the red dot may represent multiple data points). To 
see the clustered data points, click the small arrow on the top right corner of the data box to scroll 
between surveys. 

Figure 30. Data viewed using the visualization tab

Figure 31. Disable or adjust clustering points to find sampling location

Cluster Points Arrow to scroll

Enabled Clustering Menu

Tip

Not seeing all of your data points? 
Check the clustering settings or, in 
the dialog box, click the arrow on 

the right.

Retrieving your Sanitary Survey Data
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View your data using the Map Viewer

Figure 32 shows data viewed using Map Viewer. Use the menu on the left-hand side to view the 
data for different parts of the survey. To see and toggle between tables in the Map Viewer, select 
the section of the survey you would like to see, then click the chart icon . You can also click on 
a data point on the map to view your data.  To leave the map viewer, click the back button on your 
browser.

Step A.5. Exporting your data

To download your data, click Export Data. All layers and tables will be exported as one zip file, or as 
individual layers/tables (Figure 33).

Figure 32. Data display in map viewer

Important

You may need to adjust 
the map in order to view 

the data which is included 
as a row in the table below 

the map

2. View different parts of the survey 
by using this menu

1. Adjust map size by moving up the map 
adjustment tool to view

Figure 33. Options for exporting data from the GeoPlatform

1. Export all data as a .zip file

2. Export data from an individual 
layer/table by clicking on the file 

to open in a new window and select 
Export data

Retrieving your Sanitary Survey Data
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When you choose to export data, it will not be exported im-
mediately. Instead, you will have to save it as a new item in 
the EPA’s ESRI GeoPlatform. In this example, I have chosen 
to Export to a CSV file. You can provide your exported file a 
name, tags, etc. Click Enter to add one or more tags in order 
to activate the Export button. Add Summary (optional) and 
Change Save in Folder location. Click Export to create a new 
item in the EPA’s GeoPlatform (Figure 34).  

After exporting your new item, you will be routed to the new item’s page in the GeoPlatform. You will 
see a Download button on the right-hand side of the page. Click Download to download the .zip file 
to your local workstation (Figure 35). See Figure 36 for an example of the data output files in the 
.zip file. 

Note that if you need to find this file again, click 
on the Content tab at the top of the page after 
logging into the GeoPlatform. This will take you 
to your Content “home,” where you will be able 
to view all content you own in the EPA’s GeoPlat-
form. 

Tip

The export data button will not export the 
data immediately -- you will first have to 
save it as a new item in the EPA’s ESRI 

GeoPlatform. 

Photos will need to be downloaded sepa-
rately; see Step A.6. Figure 34. Exporting data from GeoPlatform

Figure 35. New items screen to download data

Retrieving your Sanitary Survey Data

Figure 36. Example exported data file
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Step A.6. Download your Photos

To find, view, and save your survey photos, select the 
survey section where photos were taken or sections 
entitled “Image Repeat” from the dropdown menu (Figure 
37) in the Data tab.

You can view your photos by clicking on links under Photos and Files (Figure 38). This will open to 
the individual photo to allow you to view each photo. To save the photo, right click on the photo and 
then select Save Image As and specify where you would like the photo saved. This process will have 
to be repeated for each photo. 

Tip

Find your photos in Image 
Repeat or in the sections 
of the survey where pho-

tos were taken

Figure 37. Finding your photos

Figure 38. Viewing and saving your photos

Retrieving your Sanitary Survey Data
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Option B: Retrieving Data Using Survey123 Website
The Survey123 website is tied to GeoPlatform. They share users, groups, data, etc. The Survey123 
website provides another option to view and export survey data collected with the EPA Sanitary Sur-
vey App for Marine and Fresh Waters. 

Step B.1: Sign into the Survey123 website

•	 Open a web browser and navigate to the EPA’s ESRI GeoPlatform

	» https://survey123.arcgis.com/

•	 Log in with your username and password

Step B.2: View your data

Click on the My Surveys tab on the top of the page to view surveys for which you have access to 
view submitted data for in the Survey123 website (Figure 39). Surveys with data will appear with a 
record(s) number on the survey icon. 

Once you click on the survey icon for which you submitted data (Figure 39), you can view your data 
several ways: 

•	 The Overview tab provides high level information about the status of this survey such as 
summary information on the total number of surveys submitted, number of submitters, 
and the first and last date of data submission (Figure 40). 

•	 The Analyze tab provides functionality to analyze the answers to individual survey ques-
tions. This feature is currently disabled. 

•	 The Data tab provides a map and table view of the data you have submitted. You can 
filter the data, generate reports, etc… and export your data in several formats (Figures 41 
and 42).

Figure 39. My Surveys in Survey123 for ArcGIS
To quickly access your data, 

click this Data icon.

Retrieving your Sanitary Survey Data
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View your data in the Data tab

Select Data (Figure 41). Note: If your survey data does not display 
as shown in Figure 41 you may need refresh your view (CTRL F5 [PC] 
or Command R [Mac]). In the data tab you can view you data in two 
ways: 

(1) View your data in the table at the bottom of the window (Figure 
41). You may need to adjust the table size by pulling the table 
tab up. Here you can toggle between data tables. 

Tip

If you’re having problems re-
viewing your data click CTRL 
F5 (PC) or Command R (Mac) 

to reload data screen.

Figure 40. Overview tab Survey123 ArcGIS

Figure 41. View the data in a table in Survey123 ArcGIS

1. View sections of the survey

Your survey data

Retrieving your Sanitary Survey Data

Adjust table size
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(2) View your data by clicking your sampling location point 
on the map (Figure 42). This will open a new window 
display to the right of the map where you can scroll 
through your data and photos as they appear in the 
sanitary survey app. 

Step B.3 Exporting Your Data

To download survey data, on the Data tab, select Export in the toolbar above the map (Figure 43). 
Choose your preferred format for the export file. After some processing time, the file will download 
to your local workstation. Note: You can filter the results before exporting them. If you do this, the 
exported file will only contain the filtered data. 

To download your photos, select your sampling location point on the map (Figure 43). Scroll through 
this window to view photos. Right click on photos and select Save Image As to save photos.

Tip

Click data points on your map to view 
data and photos in the side pane

Figure 42. View the data and photos in the side window in Survey123 ArcGIS

Retrieving your Sanitary Survey Data

Figure 43. Exporting your data and saving your photos in Survey123 ArcGIS

Export button to export data

Right-click, 
save as to save 

photos

2. View data in side display window


